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Safety warning notice

/A WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the
AC adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description
Product name HP Mini 5101
Processor Intel® Atom™ N280 1.66-GHz processor, 512-KB Level 2 cache, 533-MHz front-

side bus (FSB)

Intel Atom N270 1.6-GHz processor, 512-KB Level 2 cache, 533-MHz front-side
bus (FSB)

Chipset Northbridge: Intel 945GSE; 533-MHz bus speed

Southbridge: Intel ICH7M

Graphics Intel® Graphics Media Accelerator 950

Universal Memory Architecture (UMA) graphics subsystem

Panel Wide-aspect 16:9 ratio panels

All display assemblies include 1 webcam, 2 microphones, and 2 wireless local-area
network (WLAN) antenna transceivers/cables. (WWAN is optional.)

10.1-inch high-definition AntiGlare LED

10.1-inch standard-definition AntiGlare LED

Memory One customer-accessible/upgradable memory module slot

Supports up to 2 GB of system memory

PC2-5300, 533-MHz, DDR2

Supports the following configurations:

e  2048-MB total system memory (2048 x 1)

NOTE: Not supported by computers with Windows® XP Home SP3, ultra low-
cost personal computer (ULCPC) edition installed.

e  1024-MB total system memory (1024 x 1)

Hard drive Supports all 9.5-mm, 6.35-cm (2.50-inch) parallel SATA hard drives

320-GB, 7200-RPM

250-GB, 7200-RPM

160-GB, 7200-RPM

Optical drive Supports external USB optical drives only

Diskette drive Supports external USB diskette drives only




Category Description

Audio/Visual High-definition (HD) audio

Integrated speakers (2)

Fixed integrated stereo microphones (2)

Fixed integrated 2-MP webcam

Modem Supports external USB modems only
Ethernet Integrated 10/100/1000 Wake On LAN network interface card (NIC)
Wireless 2 WLAN antennas built into display assembly

Integrated 802/11/a/b/g/n WLAN module

Integrated WWAN (optional)

NOTE: Not supported by computers with Linux installed.

Integrated WPAN Bluetooth® module

External media cards Media Card Reader with push-push technology supporting:
e  MultiMediaCard (MMC)

e  Secure Digital (SD) Memory Card

Ports Audio-in (stereo microphone)

Audio-in/out (microphone/stereo headphone)

Audio-in (microphone)

RJ-45 (Ethernet, includes link and activity lights)

USB (3)

VGA hot-plug external monitor

3-pin AC power

Keyboard/pointing device 92% keyboard

TouchPad, with 2 TouchPad buttons and 2-way scrolling (taps enabled as default)

Power requirements 65-W Smart AC adapter with localized cable plug support

AC adapter connector on cable

6-cell lithium-polymer (Li-Pol) battery (2.55-Ah, 55-Wh), 6-hour target life

4-cell prismatic battery (2.55-Ah, 29-Wh), 3-hour target life

Security Supports HP Kensington Security Lock

Operating system Preinstalled:

Windows® XP Home SP3, ultra low-cost personal computer (ULCPC) edition

Windows Vista® Business 32 SP1 (with XP Pro image)

SUSE Linux SLED 11

Serviceability Customer Self-Replacement (CSR):

AC adapter

2 Chapter 1 Product description



Category

Description

Battery (system)

Memory module

Keyboard

WLAN

Hard drive
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2 External component identification

Components included with the computer may vary by region and model. The illustrations in this chapter
identify the standard features on most computer models.

Top components
TouchPad

Component

Description

1) TouchPad

Moves the pointer and selects or activates items on the screen.

(2) Left TouchPad button

Functions like the left button on an external mouse.

3) Right TouchPad button

Functions like the right button on an external mouse.

(4) TouchPad scroll zone

Scrolls up or down.

Chapter 2 External component identification



Lights

Component Description

(1) Caps lock light On: Caps lock is on.

(2) Quick Launch Web light On: The default Internet browser is being launched.
(3) Quick Launch Mail light On: The default mail application is being launched.
(4) Power light e  On: The computer is on.

e  Blinking: The computer is in the Sleep or Standby state.

e  Off: The computer is off or in Hibernation.

Top components 5
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Buttons

Component

Description

(1) Quick Launch Web button

Opens the default Internet browser when the computer is
on.

(2) Quick Launch Mail button

Opens the default mail application when the computer is
on.

3) Power button

e  When the computer is off, press the button to turn on
the computer.

e  When the computer is on, press the button to shut
down the computer.

e  When the computer is in the Sleep or Standby state,
press the button briefly to exit.

e  When the computer is in Hibernation, press the
button briefly to exit Hibernation.

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the
computer.

Chapter 2 External component identification



Keys

Component

Description

(1

esc key

Displays system information when pressed in combination with
the fn key.

NOTE: Only available on computers with a Windows operating
system installed.

()

fn key

Displays system information when pressed in combination with
the esc key.

NOTE: Only available on computers with a Windows operating
system installed.

(©)

Windows logo key

Displays the Windows Start menu.

NOTE: Only available on computers with a Windows operating
system installed.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.
NOTE: Only available on computers with a Windows operating
system installed.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute the action represented by the icon on the key.

Top components
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Front components

)

Component

Description

(1) Drive light

Blinking: The hard drive is being accessed.

(2) Wireless light

e  Blue: An integrated wireless device, such as a wireless local
area network (WLAN) device and/or a Bluetooth® device, is
on.

e  Amber: All wireless devices are off.

NOTE: The wireless light turns amber when the computer turns
on and all wireless devices are off.

(3) Wireless switch

Turns the wireless feature on or off, but does not create a wireless
connection.

NOTE: To establish a wireless connection, a wireless network
must already be set up.

(4) Speakers (2)

Produce sound.

Chapter 2 External component identification



Right-side components

Component

Description

()

SD Card Reader

Supports the following optional digital card formats:
e  MultiMediaCard (MMC)

e  Secure Digital (SD) Memory Card

()

Audio-out (headphone) jack

Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.

NOTE: When a device is connected to the headphone jack, the
computer speakers are disabled.

(3)

Audio-in (microphone) jack

Connects an optional computer headset microphone, stereo array
microphone, or monaural microphone.

(4)

Powered USB port

Provides power to a USB device, such as an optional external
optical drive, if used with a powered USB cable.

©)

RJ-45 (network) jack

Connects a network cable.

(6)

Security cable slot

Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or stolen.

Right-side components
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Left-side components

Component Description
(1) Battery light e  Amber: A battery is charging.

e Blue: A battery is close to full charge capacity.

e  Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins blinking
rapidly.

e  Off: If the computer is plugged into an external power source,
the light turns off when all batteries in the computer are fully
charged. If the computer is not plugged into an external power
source, the light stays off until the battery reaches a low
battery level.

(2) Power connector Connects an AC adapter.
(3) External monitor port Connects an external VGA monitor or projector.
(4) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal

components and prevent overheating. It is normal for the internal

fan to cycle on and off during routine operation.
(5) USB ports (2) Connect optional USB devices.

10 Chapter 2 External component identification



Display components

Component Description

(1) Webcam light On: The webcam is in use.

(2) Webcam Records audio and video and captures still photographs.
(3) Internal microphones (2) Record sound.

NOTE: If there is a microphone icon next to each microphone
opening, your computer has internal microphones.

(4) Speakers (2) Produce sound.

Display components 11



Bottom components

Component Description

(1) Battery bay Holds the battery.

(2) Battery release latches (2) Release the battery from the battery bay.

(3) Service tag Provides the product brand and series name, serial number (s/n),
and product number (p/n) of your computer. Have this information
available when you contact technical support.

(4) Memory module compartment Contains the memory module slot.

(5) Vents (2) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

12 Chapter 2 External component identification



Wireless antennas

On select computer models, at least 2 antennas send and receive signals from one or more wireless
devices. These antennas are not visible from the outside of the computer.

P — ] =]
o 1 o 1]

Bf NOTE: Foroptimal transmission, keep the areas immediately around the WLAN and WWAN antennas
free from obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental
Notices that applies to your country or region. These notices are located in Help and Support.

Wireless antennas
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3 lllustrated parts catalog

Service tag

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag:

(1) Product name: This is the product name affixed to the front of the device.
(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the alphanumeric identifier used to locate documents, drivers, and support
for the device.

(5) Warranty period: This number describes the duration of the warranty period for the device.

- product & 0000000000000
- sfn - xooccoceess  HTHRDIRTENERNRRNANATI0
L pdn : ccxxenooc |0 D0 L0

ia) Service | xxoo0c
‘ tag |warranty x year.

m

00
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ltem Description

Spare part number

(1) Display assembly (includes 1 webcam, 2 microphones, and 2 WLAN antenna transceivers/

cables; WWAN is optional)

See Display assembly components on page 19 for a comprehensive list of display assembly

spare parts.

e  10.1-inch, high-definition, AntiGlare display assembly with webcam (includes WWAN)  580616-001
e  10.1-inch, high-definition, AntiGlare display assembly with webcam 577969-001
e 10.1-inch, standard-definition, AntiGlare display assembly with webcam (includes 580615-001

WWAN)
e  10.1-inch, standard-definition, AntiGlare display assembly with webcam 577968-001
(2) Keyboard

e  Foruse only in Belgium 578364-A41
e  Foruse only in Brazil 578364-201
e  Foruse only in Bulgaria 578364-261
e  Foruse only in the Czech Republic 578364-221
e  Foruse only in Denmark 578364-081
e  For use only in Europe 578364-B31
e  Foruse only in France 578364-051
e  For use only in French Canada 578364-121
° For use only in Finland, and Sweden 578364-B71
e  For use only in Germany 578364-041
e  For use only in Greece 578364-DJ1
° For use only in Hungary 578364-211
° For use only in Iceland 578364-DD1
e Foruseonlyin Israel 578364-BB1
e  Foruseonlyin Italy 578364-061
e  Foruse only in Japan 578364-291
e  Foruse only in Latin America 578364-161
e  For use only in Norway 578364-091
e  For use only in Portugal 578364-131
e  Foruse only in Russia 578364-251
e  For use only in Saudi Arabia 578364-171
e  For use only in Slovakia 578364-231
e  Foruse only in Slovenia 578364-BA1
e  For use only in South Korea 578364-AD1
e  Foruse only in Spain 578364-071
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Item Description Spare part number
e  For use only in Switzerland 578364-BG1
e  Foruse only in Taiwan 578364-AB1
e  For use only in Thailand 578364-281
e  Foruse only in Turkey 578364-141
e  For use only in the United Kingdom 578364-031
e  For use only in the United States 578364-001
(3) Top cover (includes TouchPad) 577926-001
(4) Speaker assembly (includes cable) 577967-001
(5) Hard drive

NOTE: Each hard drive spare part kit includes a bracket and screws.

e 320-GB, 7200-RPM 577974-001

e 250-GB, 7200-RPM 577973-001

e 160-GB, 7200-RPM 577972-001
(6) WLAN module

802.11/a/b/g/n WLAN module

For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, 504664-001
and the United States

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, 504664-002
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt,

El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,

French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece,
Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay,
the People's Republic of China, Peru, the Philippines, Poland, Portugal,

the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino,

Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea,
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines,
Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine,

the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

For international use 480985-001

@)

Fan and heat sink assembly (includes replacement thermal material) 577924-001

(8)

System board (includes processor and replacement thermal material)

Device major components
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Item Description Spare part number
e Includes Intel Atom N280 1.66-GHz processor, 512-KB Level 2 cache, 533-MHz front-  577921-001
side bus (FSB)
e Includes Intel Atom N270 1.6-GHz processor, 512-KB Level 2 cache, 533-MHz front-side  585464-001
bus (FSB)
Plastics Kit with Bluetooth cable 577966-001
(9a) Bluetooth cable
(9b) Actuator cover
(9¢) Memory module compartment cover
(9d) Blank for Media Card Reader
(10) Bluetooth module 537921-001
(11) RTC battery 507707-001
(12) WWAN module
NOTE: Not supported by computers with Linux installed.
e  HP un2400 Mobile Broadband Module (select models only) 483377-002
e  WWAN module for use only in the People's Republic of China 571888-001
(13) Power button board (includes cable) 577922-001
(14) SIM module (includes cable) 577923-001
(15) Battery
e  6-cell lithium-polymer (Li-Pol) battery (2.55-Ah, 55-Wh) 579027-001
e  4-cell prismatic battery (2.55-Ah, 29-Wh) 579026-001
(16) Base enclosure (includes 4 rubber device feet) 577925-001
17) Memory module (PC2-5300, 533-MHz, DDR2)
e  2048-MB (Not supported by computers with Windows® XP Home SP3, ultra low-cost 577971-001
personal computer (ULCPC) edition installed.)
e 1024-MB 577970-001
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Display assembly components

Item  Description Spare part number
(1) Display bezel 577929-001
(2) Display Hinge Kit 577930-001

(Includes left and right display panel hinges)

(3) Webcam module 577927-001
(4) Display panel/webcam cable
e  For use in high-definition display assembly 577932-001
e  For use in standard-definition display assembly 577931-001
(5) Display enclosure (includes logo) 577928-001

Display Cable Kit (not illustrated, includes microphone assembly cable, WLAN antennas, 577933-001
and WWAN antennas)
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Miscellaneous parts

Description Spare part number
65-W, 3-pin Smart AC adapter 463958-001
65-W, 3-pin Smart AC adapter for use in India 577170-001
Power cord

e  Foruse in Argentina 490371-D01
e Forusein Australia 490371-011
e Foruse in Brazil 490371-201
e  Forusein Denmark 490371-081
e Forusein Europe 490371-021
e Forusein India 490371-D61
e Forusein Israel 490371-BB1
e  Forusein ltaly 490371-061
e  Foruse in Japan 490371-291
e  Foruse in North America 490371-001
e  For use in the People's Republic of China 490371-AA1
e  Foruse in Singapore and the United Kingdom 490371-031
e  For use in South Africa 490371-AR1
e  Forusein South Korea 490371-AD1
e  Foruse in Switzerland 490371-111
e Forusein Taiwan 490371-AB1
Rubber Kit (contains 10 rubber device feet—5 front and 5 rear) 578361-001
Screw Kit 578362-001
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Sequential part number listing

Spare part Description

number

463958-001 65-W, 3-pin Smart AC adapter

480985-001 802.11/a/b/g/n WLAN module for international use

483377-002 HP un2400 Mobile Broadband Module (select models only)
NOTE: Not supported by computers with Linux installed.

490371-001 Power cord for use in North America

490371-011 Power cord for use in Australia

490371-021 Power cord for use in Europe

490371-031 Power cord for use in Singapore and the United Kingdom

490371-061 Power cord for use in ltaly

490371-081 Power cord for use in Denmark

490371-111 Power cord for use in Switzerland

490371-201 Power cord for use in Brazil

490371-291 Power cord for use in Japan

490371-AA1 Power cord for use in the People's Republic of China

490371-AB1 Power cord for use in Taiwan

490371-AD1 Power cord for use in South Korea

490371-AR1 Power cord for use in South Africa

490371-BB1 Power cord for use in Israel

490371-D01 Power cord for use in Argentina

490371-D61 Power cord for use in India

504664-001 802.11/a/b/g/n WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin

Islands, and the United States

Sequential part number listing 21



Spare part
number

Description

504664-002

802.11/a/b/g/in WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the
British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African
Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial
Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, ltaly, the Ivory Coast, Jamaica, Jordan,
Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of
China, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa,
San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

507707-001

RTC battery

537921-001

Bluetooth module

571888-001

WWAN module for use only in the People's Republic of China (Not supported by computers with Linux
installed.)

577170-001

65-W, 3-pin Smart AC adapter

577921-001

System board, includes Intel Atom N280 1.66-GHz processor, 512-KB Level 2 cache, 533-MHz front-side bus
(FSB) (includes thermal replacement material)

577922-001

Power button board (includes cable)

577923-001

SIM module (includes cable)

577924-001

Fan and heat sink assembly (includes thermal replacement material)

577925-001

Base enclosure (includes 4 rubber device feet)

577926-001

Top cover (includes TouchPad)

577927-001

Webcam module

577928-001

Display enclosure (includes logo)

577929-001

Display bezel

577930-001

Display hinge kit (Includes left and right display panel hinges)

577931-001

Display panel/webcam cable for use with standard-definition display assembly

577932-001

Display panel/webcam cable for use with high-definition display assembly

577933-001

Display Cable Kit (includes microphone assembly cable, WLAN antennas, and WWAN antennas)

577966-001

Plastics Kit with Bluetooth cable

577967-001

Speaker assembly (includes cable)

577968-001

10.1-inch, standard-definition, AntiGlare display assembly with webcam (includes 2 microphones, and 2 WLAN
antenna transceivers/cables)
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Spare part Description

number

577969-001 10.1-inch, high-definition, AntiGlare display assembly with webcam (includes 2 microphones, and 2 WLAN
antenna transceivers/cables)

577970-001 1024-MB memory module (PC2-5300, 533-MHz, DDR2)

577971-001 2048-MB memory module (PC2-5300, 533-MHz, DDR2)
(Not supported by computers with Windows® XP Home SP3, ultra low-cost personal computer (ULCPC)
edition installed.)

577972-001 160-GB, 7200-RPM hard drive (includes bracket and screws)

577973-001 250-GB, 7200-RPM hard drive (includes bracket and screws)

577974-001 320-GB, 7200-RPM hard drive (includes bracket and screws)

578361-001 Rubber Kit (contains 10 rubber device feet—>5 front and 5 rear)

578362-001 Screw Kit

578364-001 Keyboard for use only in the United States

578364-031 Keyboard for use only in the United Kingdom

578364-041 Keyboard for use only in Germany

578364-051 Keyboard for use only in France

578364-061 Keyboard for use only in Italy

578364-071 Keyboard for use only in Spain

578364-081 Keyboard for use only in Denmark

578364-091 Keyboard for use only in Norway

578364-121 Keyboard for use only in French Canada

578364-131 Keyboard for use only in Portugal

578364-141 Keyboard for use only in Turkey

578364-161 Keyboard for use only in Latin America

578364-171 Keyboard for use only in Saudi Arabia

578364-201 Keyboard for use only in Brazil

578364-211 Keyboard for use only in Hungary

578364-221 Keyboard for use only in the Czech Republic

578364-231 Keyboard for use only in Slovakia

578364-251 Keyboard for use only in Russia

578364-261 Keyboard for use only in Bulgaria

578364-281 Keyboard for use only in Thailand

578364-291 Keyboard for use only in Japan

578364-A41 Keyboard for use only in Belgium

578364-AB1 Keyboard for use only in Taiwan
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Spare part Description
number

578364-AD1 Keyboard for use only in South Korea

578364-B31 Keyboard for use only in Europe

578364-B71 Keyboard for use only in Finland, and Sweden

578364-BA1 Keyboard for use only in Slovenia

578364-BB1 Keyboard for use only in Israel

578364-BG1 Keyboard for use only in Switzerland

578364-DD1 Keyboard for use only in Iceland

578364-DJ1 Keyboard for use only in Greece

579026-001 4-cell prismatic battery (2.55-Ah, 29-Wh)

579027-001  6-cell lithium-polymer (Li-Pol) battery (2.55-Ah, 55-Wh)

580615-001 10.1-inch, standard-definition, AntiGlare display assembly with webcam and WWAN (includes 2 microphones,
and 2 WLAN antenna transceivers/cables)

580616-001 10.1-inch, high-definition, AntiGlare display assembly with webcam and WWAN (includes 2 microphones, and
2 WLAN antenna transceivers/cables)

585464-001 System board, includes Intel Atom N270 1.6-GHz processor, 512-KB Level 2 cache, 533-MHz front-side bus
(FSB) (includes replacement thermal material)
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:
e Flat-bladed screwdriver
e  Magnetic screwdriver

e Phillips PO and P1 screwdrivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

B NOTE: As you remove each subassembly from the device, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

/A CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.

Cables and connectors

/A CAUTION: When servicing the device, be sure that cables are placed in their proper locations during
the reassembly process. Improper cable placement can damage the device.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.

Preliminary replacement requirements
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Drive handling

/\ CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
device, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the device. If you are unsure whether the device
is off or in Hibernation, turn the device on, and then shut it down through the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

/A CAUTION: To preventdamage to the device when you are removing or installing internal components,
observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.
Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

/\ CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000V 15,000 V 7,500 V
Walking across vinyl floor 12,000 V 5,000 V 3,000V
Motions of bench worker 6,000 V 800V 400 V
Removing DIPS from plastic tube 2,000 V 700 V 400 V
Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V
Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.
Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.
Place items on a grounded surface before removing items from their containers.

Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials are
selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm +£10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

Antistatic tape

Antistatic smocks, aprons, and sleeve protectors

Conductive bins and other assembly or soldering aids
Nonconductive foam

Conductive tabletop workstations with ground cords of one megohm resistance
Static-dissipative tables or floor mats with hard ties to the ground
Field service kits

Static awareness labels

Material-handling packages

Nonconductive plastic bags, tubes, or boxes

Metal tote boxes

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastic Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500 V
Metallized laminate Floor mats 5,000 V

Preliminary replacement requirements



Component replacement procedures

This chapter provides removal and replacement procedures.

There are as many as 65 screws, in 9 different sizes, that must be removed, replaced, or loosened when
servicing the device. Make special note of each screw size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag:

(1) Product name: This is the product name affixed to the front of the device.
(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the alphanumeric identifier used to locate documents, drivers, and support
for the device.

(5) Warranty period: This number describes the duration of the warranty period for the device.

@ product : uooocoooono
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Device feet

The device feet are adhesive-backed rubber pads. The rear feet are attached and the front feet are
tethered to the bottom of the base enclosure.

Bf NOTE: The front and rear device feet are not interchangeable. Due to the adhesive nature of the
rubber pads, they should be replaced after removal.

Description Spare part number

Rubber Kit (contains 10 rubber device feet—>5 front and 5 rear) 578361-001
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Battery

Description Spare part number
6-cell lithium-polymer (Li-Pol) battery (2.55-Ah, 55-Wh) 579027-001
4-cell prismatic battery (2.55-Ah, 29-Wh) 579026-001

Before removing the battery, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

Remove the battery:

1. Turn the device upside-down on a flat surface, with the battery bay toward you.
2. Slide the battery release latches (1) to release the battery.

3.  Remove the battery (2).

Reverse this procedure to install a battery.
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SIM

Bf NOTE: This section applies only to device models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 32).

Remove the SIM:
1.  Pressin on the SIM (1). (The module is partially ejected from the SIM slot.)
2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to insert the SIM.
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Memory module

Description Spare part number

2048-MB, PC2-5300, 533-MHz, DDR2 (Not supported by computers with Windows® XP Home SP3, 577971-001
ultra low-cost personal computer (ULCPC) edition installed.)

1024-MB, PC2-5300, 533-MHz, DDR2 577970-001

Before removing the memory module, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 32).

5. If your device has WWAN capability, remove the SIM (see SIM on page 33).

Remove the memory module:

1. Use a fingernail or other flexible tool (1) to release the memory module compartment cover from
the computer.

2. Swing the cover up and away from the outside of the computer (2), and then remove the
cover (3).

3. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The module tilts up.)
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4. Remove the memory module (2) by pulling the module away from the slot at an angle.

¥ NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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Keyboard

Description Spare part number
For use only in Belgium 578364-A41
For use only in Brazil 578364-201
For use only in Bulgaria 578364-261
For use only in the Czech Republic 578364-221
For use only in Denmark 578364-081
For use only in Europe 578364-B31
For use only in France 578364-051
For use only in French Canada 578364-121
For use only in Finland, and Sweden 578364-B71
For use only in Germany 578364-041
For use only in Greece 578364-DJ1
For use only in Hungary 578364-211
For use only in Iceland 578364-DD1
For use only in Israel 578364-BB1
For use only in Italy 578364-061
For use only in Japan 578364-291
For use only in Latin America 578364-161
For use only in Norway 578364-091
For use only in Portugal 578364-131
For use only in Russia 578364-251
For use only in Saudi Arabia 578364-171
For use only in Slovakia 578364-231
For use only in Slovenia 578364-BA1
For use only in South Korea 578364-AD1
For use only in Spain 578364-071
For use only in Switzerland 578364-BG1
For use only in Taiwan 578364-AB1
For use only in Thailand 578364-281
For use only in Turkey 578364-141
For use only in the United Kingdom 578364-031
For use only in the United States 578364-001

Before removing the keyboard, follow these steps:
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1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 32).

5.  If your device has WWAN capability, remove the SIM (see SIM on page 33).

Remove the keyboard:

1. Remove the 3 Phillips PM2.0%3.0 screws that secure the keyboard to the device.

2.  Open the display 90 degrees.

3. Use a tool to push the screw tabs directly down to release the keyboard.

4.  Turn the device right-side up, and then lift up on the top and left edges (1) of the keyboard until the
keyboard releases completely.
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5. Swing the keyboard forward (2), and slide the keyboard back until its top edge rests on the display
assembly (3).

6. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached.

7. Disconnect the cable (2).

8. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Hard drive

Bf NOTE: Each hard drive spare part kit includes a bracket and screws.

Description Spare part number
320-GB, 7200-RPM 577974-001
250-GB, 7200-RPM 577973-001
160-GB, 7200-RPM 577972-001

Before removing the hard drive, follow these steps:

1.

5.
6.

Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

Disconnect all external devices connected to the device.

Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

Remove the battery (see Battery on page 32).

If your device has WWAN capability, remove the SIM (see SIM on page 33).

Remove the keyboard (see Keyboard on page 36).

Remove the hard drive:

1.

Loosen the Phillips PM2.5%11.0 captive screw (1), and remove the 2 Phillips PM2.0x3.0
screws (2) that secure the hard drive assembly to the base enclosure.

Use the Mylar tab to slide the assembly to the right (3) to disconnect it, and remove the
assembly (4).

Remove the 4 Phillips SP2.0x3.0 screws (1) that secure the hard drive bracket to the hard drive.
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4. Using the Mylar tab, lift the bracket (2) away from the hard drive.

Reverse this procedure to install a hard drive.
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WLAN module

Description Spare part number

802.11/a/b/gin WLAN module

For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, 504664-001
and the United States

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina, 504664-002
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon,

Cape Verde, the Central African Republic, Chad, Chile, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica,

the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana,
Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the lvory Coast,
Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia,
the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal,
the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru,
the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa,
San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles,

Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa,
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines,
Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine,

the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

For international use 480985-001

/A CAUTION: The WWAN module and the WLAN module are not interchangeable.

To prevent an unresponsive system, replace the wireless module only with a wireless module authorized
for use in the device by the governmental agency that regulates wireless devices in your country or
region. If you replace the module and then receive a warning message, remove the module to restore
device functionality, and then contact technical support through Help and Support.

Before removing the WLAN module, follow these steps:

1.

Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

Disconnect all external devices connected to the device.

Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

Remove the battery (see Battery on page 32).
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5.  If your device has WWAN capability, remove the SIM (see SIM on page 33).
6. Remove the following components:

a. Keyboard (see Keyboard on page 36)

b. Hard drive (see Hard drive on page 39)

Remove the WLAN module:
1. Disconnect the wireless antenna cables (1) from the terminals on the WLAN module.

2. Remove the 2 Phillips PM2.0x4.0 screws (2) that secure the WLAN module to the system board.
(The module tilts up.)

3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

Bf NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion into the WLAN
module slot.

@

Reverse this procedure to install the WLAN module.
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SIM module

Description Spare part number

SIM module (includes cable) 577923-001

Before removing the SIM module, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

bl

Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

Remove the battery (see Battery on page 32).

Remove the SIM (see SIM on page 33).

Remove the Keyboard (see Keyboard on page 36).

N o o &

Remove the Hard drive (see Hard drive on page 39).
Remove the SIM module:

[0 Disconnect the LIF cable (1) from the computer, and remove the SIM module (2).

Reverse this procedure to install the SIM module.
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Top cover

Description Spare part number

Top cover (includes TouchPad) 577926-001

Before removing the top cover, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

d

Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

Remove the battery (see Battery on page 32).

If your device has WWAN capability, remove the SIM (see SIM on page 33).

Remove the memory module (see Memory module on page 34).

Remove the keyboard (see Keyboard on page 36).
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Remove the hard drive (see Hard drive on page 39).

Remove the top cover:
1. Turn the device upside down, with the front toward you.
2. Use a thin, flat tool to release the 4 rubber device feet.

3. Remove the 4 Torx T8 2.5%5.0 screws (1), and the 4 Phillips PM2.0x%3.0 screws (2) that secure the
top cover to the base enclosure.

4. Turn the device right-side up, with the front toward you.
5. Open the device as far as possible.

6. Release the ZIF connector (1) that connects the button board cable to the system board.
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7. Remove the following screws that secure the top cover to the base enclosure:
e (2)-4 Phillips BP2.0x6.0
e (3)-1 Phillips BP2.0x7.0
e (4)-1 Phillips SP2.0x2.0
e (5)-1 Phillips BP2.0%2.0

o

9. Release the ZIF connector (1) to which the TouchPad button board cable is connected, and
disconnect the cable (2) from the system board.
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10. Disconnect the speaker cable (3) from the system board, and then remove the top cover.

Reverse this procedure to install the top cover.
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Speaker

Description Spare part number

Speaker assembly (includes cable) 577967-001

Before removing the speaker assembly, follow these steps:

1.

d
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Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

Disconnect all external devices connected to the device.

Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

Remove the battery (see Battery on page 32).

If your device has WWAN capability, remove the SIM (see SIM on page 33).

Remove the memory module (see Memory module on page 34).

Remove the keyboard (see Keyboard on page 36).

Remove the hard drive (see Hard drive on page 39).

Remove the top cover (see Top cover on page 44).

Remove the speaker assembly:

1.
2.

Turn the top cover upside down, with the front toward you.

Remove the 2 Phillips PMP2.0%3.0 screws (1) that secure the assembly to the top cover, and
remove the speaker assembly (2).

Reverse this procedure to install the speaker assembly.
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WWAN module
Bf NOTE: Not supported by computers with Linux installed.

Description Spare part number
HP un2400 Mobile Broadband Module (select models only) 483377-002
WWAN module for use only in the People's Republic of China 571888-001

/A CAUTION: The WWAN module and the WLAN module are not interchangeable.

To prevent an unresponsive system, replace the wireless module only with a wireless module authorized
for use in the device by the governmental agency that regulates wireless devices in your country or
region. If you replace the module and then receive a warning message, remove the module to restore
device functionality, and then contact technical support.

Before removing the WWAN module, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 32).

5. Remove the SIM (see SIM on page 33).

6. Remove the following components:

a. Keyboard (see Keyboard on page 36)

b. Hard drive (see Hard drive on page 39)

c. Top cover (see Top cover on page 44)

Remove the WWAN module:

1. Disconnect the wireless antenna cables (1) from the terminals on the WWAN module.

B NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2. Remove the 2 Phillips PM2.0x4.0 screws (2) that secure the WWAN module (3) to the system
board. (The module tilts up.)
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3.  Remove the WWAN module (3) by pulling the module away from the slot at an angle.

B NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion into the
WWAN module slot.

Reverse this procedure to install the WWAN module.
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Bluetooth module

Description Spare part number

Bluetooth module 537921-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 32).

5.  If your device has WWAN capability, remove the SIM (see SIM on page 33).

6. Remove the following components:

a. Keyboard (see Keyboard on page 36)

b. Hard drive (see Hard drive on page 39)

c. Top cover (see Top cover on page 44)

Remove the Bluetooth module:
1. Disconnect the Bluetooth module cable (1).

2. Release the Bluetooth module from the adhesive pad to which it is affixed (2), and remove the
Bluetooth module.

Reverse this procedure to install the Bluetooth module.
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Power button board

Description Spare part number

Power button board (includes cable) 577922-001

Before removing the power button board, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 32).

5.  If your device has WWAN capability, remove the SIM (see SIM on page 33).

6. Remove the following components:

a. Keyboard (see Keyboard on page 36)

b. Hard drive (see Hard drive on page 39)

c. Top cover (see Top cover on page 44)

Remove the power button board:
1. Disconnect the power button board cable (1).

2. Remove the 3 Phillips PM2.0x2.0 broadhead screws (2) that secure the power button board to the
base enclosure.

3. Remove the power button board (3).

Reverse this procedure to install the power button board.
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Display assembly

Description Spare part number

Display assembly (includes 1 webcam, 2 microphones, and 2 WLAN antenna
transceivers/cables; WWAN is optional)

e 10.1-inch, high-definition, AntiGlare display assembly with webcam (includes 580616-001

WWAN)
e  10.1-inch, high-definition, AntiGlare display assembly with webcam 577969-001
e  10.1-inch, standard-definition, AntiGlare display assembly with webcam (includes 580615-001
WWAN)
e  10.1-inch, standard-definition, AntiGlare display assembly with webcam 577968-001
Display bezel 577929-001
Display Hinge Kit 577930-001

(Includes left and right display panel hinges)

Webcam module 577927-001

Display panel/lwebcam cable

e  For use with high-definition display assembly 577932-001
e  For use with standard-definition display assembly 577931-001
Display Cable Kit (includes microphone assembly cable, WLAN antennas, and 577933-001

WWAN antennas)

Display enclosure (includes logo) 577928-001

Before removing the display assembly, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 32).

5.  If your device has WWAN capability, remove the SIM (see SIM on page 33).

6. Remove the following components:

a. Keyboard (see Keyboard on page 36)

b. Hard drive (see Hard drive on page 39)

c. Top cover (see Top cover on page 44)
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Remove the display assembly:
1. Disconnect the following cables and grounding tape from the system board:
(1) Display panel cable
(2) Display panel cable grounding tape
(3) WLAN cables
(4) WWAN cables (select models only)

(5) Microphone cable

/\ CAUTION: Support the display assembly when removing the following screws. Failure to support
the display assembly can result in damage to the display assembly and other device components.

2. Remove the 2 Phillips PM2.5x6.0 screws (1) that secure the display assembly to the device.

3.  Remove the display assembly (2).

4. Ifitis necessary to replace the display bezel, perform the following steps:

a. Flex the inside edges of the left and right sides (1), and then the top and bottom (2) of the
display bezel until the bezel disengages from the display enclosure.
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b. Remove the display bezel (3).

5. Ifitis necessary to replace the webcam module, perform the following steps:
a. Lift the webcam (1).

b. Disconnect the webcam cable (2) from the webcam.

Y

c. Remove the webcam.
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6. Ifitis necessary to replace the display panel/webcam cable, perform the following steps:

a. Remove the 6 Phillips PM2.5%5.0 screws that secure the display panel to the display
enclosure.

o

Lift the display panel up from the display enclosure (1).

o

Disengage the display panel cable (2) from the left hinge clip.

d. Remove the display panel (3) from the display enclosure.

e. Turn the display panel over, and peel back the Mylar protection (1) on the back of the display
panel.
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f.  Lift the adhesive strip (2) that secures the cable to the back of the display panel, and
disconnect the display panel/webcam cable (3).

g. Remove the display panel/webcam cable.

7. Ifitis necessary to replace the display hinges, perform the following steps:

a. Remove the 2 Phillips PM2.0%3.0 screws (1) that secure each hinge to the display panel.
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b. Remove the hinges (2).

8. Ifitis necessary to replace the microphone receiver, perform the following steps:
a. Release the microphone receiver from the clip (1) that secures it to the display enclosure.

b. Pull the receiver through the tabs (2), and remove the microphone receiver (3).

—
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9. Ifitis necessary to replace the wireless antenna transceivers and cables, perform the following
steps:

a. Detach the cables from the adhesive (1), and then route them through the clips (2) that secure
them to the display enclosure.

b. Remove the wireless antenna transceivers and cables.

Reverse this procedure to reassemble and install the display assembly.
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System board

Description Spare part number

System board (includes processor and replacement thermal material)

Includes Intel Atom N280 1.66-GHz processor, 512-KB Level 2 cache, 533-MHz front-side bus 577921-001
(FSB)

Includes Intel Atom N270 1.6-GHz processor, 512-KB Level 2 cache, 533-MHz front-side bus ~ 585464-001
(FSB)

Before removing the system board, follow these steps:

1.

Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

Disconnect all external devices connected to the device.

Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

Remove the battery (see Battery on page 32).

If your device has WWAN capability, remove the SIM (see SIM on page 33).

Remove the following components:

a. Keyboard (see Keyboard on page 36)

b. Hard drive (see Hard drive on page 39)

c. Top cover (see Top cover on page 44)

d. Display assembly (see Display assembly on page 52)

When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:

WLAN module (see WLAN module on page 41)

WWAN module, if included (see WWAN module on page 48)

Bluetooth module (see Bluetooth module on page 50)
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Remove the system board:

1. Remove the Phillips PM2.0x3.0 screw that secures the system board to the base enclosure.

=
I
I
|

2. Grasp the system board at the midpoint of the board (1), and tilt it up to the left (2).

3. Pull the system board (3) out to the right at an angle to remove it, and remove the actuator
cover (4).

Reverse the procedure to install the system board.
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RTC battery

Description Spare part number

RTC battery 507707-001

Before removing the real-time clock (RTC) battery, follow these steps:

1.

b

© © N o a &

10.

Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

Disconnect all external devices connected to the device.

Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

Remove the battery (see Battery on page 32).

If your device has WWAN capability, remove the SIM (see SIM on page 33).

Remove the Keyboard (see Keyboard on page 36).

Remove the Hard drive (see Hard drive on page 39).

Remove the Top cover (see Top cover on page 44).

Remove the Display assembly (see Display assembly on page 52).

Remove the System board (see System board on page 59).

Remove the RTC battery:

1.
2.
3.

Turn the system board upside down.
Disconnect the RTC battery cable (1) from the system board.
Detach the RTC battery (2) from the system board.

Bf NOTE: The RTC battery is attached to the system board with double-sided tape.
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Reverse this procedure to install the RTC battery.
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Fan and heat sink assembly

Description Spare part number

Fan and heat sink assembly (includes replacement thermal material) 577924-001

Bf NOTE: To properly ventilate the device, allow at least a 7.6-cm (3-inch) clearance on the left side of
the device. The device uses an electric fan for ventilation. The fan is controlled by a temperature sensor
and is designed to turn on automatically when high temperature conditions exist. These conditions are
affected by high external temperatures, system power consumption, power management/battery
conservation configurations, battery fast charging, and software requirements. Exhaust air is displaced
through the ventilation grill located on the left side of the device.

Before removing the fan and heat sink assembly, follow these steps:

1.

Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

Disconnect all external devices connected to the device.

Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

Remove the battery (see Battery on page 32).

If your device has WWAN capability, remove the SIM (see SIM on page 33).

Remove the following components:

a. Keyboard (see Keyboard on page 36)

b. Hard drive (see Hard drive on page 39)

c. Top cover (see Top cover on page 44)

d. Display assembly (see Display assembly on page 52)

e. System board (see System board on page 59)
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Remove the fan and heat sink assembly:

1. Disconnect the fan cable from the system board.

2. Loosen the 4 Phillips PM2.0x7.0 captive screws (1) that secure the fan and heat sink assembly to
the system board.

Bf NOTE: The screws are numbered 1 through 4. Follow this order when removing the screws.

3.  Remove the 2 Phillips PM2.0%3.0 screws (2) that secure the fan and heat sink assembly to the
system board.

4. Remove the fan and heat sink assembly (3).

Bf NOTE: The thermal material must be thoroughly cleaned from the surfaces of the fan and heat sink
assembly and the system board each time the fan and heat sink assembly is removed. Thermal paste
is used on the processor (1) and (3), and thermal tape is used on the Northbridge chip (2) and (4).
Replacement thermal material is included with all fan and heat sink assembly, and system board spare
part Kits.
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Reverse this procedure to install the fan and heat sink assembly.
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5 Computer Setup

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

Bf NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to navigate
and make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB legacy
support is enabled.

To start Computer Setup, follow these steps:
1. Turn on or restart the computer.

2. Before your operating system opens and while the “F10=ROM Based Setup” message is displayed
in the lower-left corner of the screen, press f10.
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Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

Because Computer Setup is not operating system based, it does not support the TouchPad.
Navigation and selection are by keystroke:

e To choose a menu or a menu item, use the arrow keys.
e To select an item, press enter.
e To close open dialog boxes and return to the main Computer Setup screen, press esc.
e To view navigation information, press f1.
e To change the language, press f2.
2. Select the File, Security, Diagnostics, or System Configuration menu.
3. To exit Computer Setup, choose one of the following methods:

e To exit Computer Setup without saving your preferences, use the arrow keys to select File
> Ignore changes and exit. Then follow the instructions on the screen.

e To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
changes and exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore defaults, and then press enter.
3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
changes and exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Bf NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus

The menu tables in this section provide an overview of the Computer Setup options.

Bf NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your

computer.
File menu

Select To do this

System information e View identification information for the computer.

e View specification information for the processor, cache
and memory size, and system ROM.

Restore defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Password settings and security
settings are not changed when you restore the factory
settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then

exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

Bf NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select

To do this

Setup password

Enter, change, or delete a setup password.

Power-on password

Enter, change, or delete a power-on password.

Password options

e Enable/disable stringent security.

e Enable/disable the password requirement on computer
restart.

DriveLock passwords

e  Enable or disable DriveLock on any computer hard drive.

e  Enter, change, or disable DriveLock on an optional
MultiBay hard drive.

NOTE: DrivelLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

System IDs

Enter a user-defined computer asset tracking number and
ownership tag.

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive. The following options are available:

e Fast: Runs the Disk Sanitizer erase cycle once.
e  Optimum: Runs the Disk Sanitizer erase cycle 3 times.

e  Custom: Allows you to select the desired number of Disk
Sanitizer erase cycles from a list.

CAUTION: If you run Disk Sanitizer, the data on the primary
hard drive is destroyed permanently.

Diagnostics menu

Select

To do this

HDD Self-Test Options

Run a comprehensive self-test on any hard drive in the system
or on any optional MultiBay hard drive.

Memory Check

Run a comprehensive check on system memory.
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System Configuration menu

Bf NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this
Language Change the Computer Setup language.
Boot options e Setanf9, f10, and f12 delay when starting up.

Enable/disable CD-ROM boot.
Enable/disable floppy boot.
Enable/disable internal network adapter boot.

Enable/disable MultiBoot, which sets a boot order that
can include most boot devices in the system.

Set the Express Boot Popup delay in seconds.
Set the boot order.

° 1st boot device: USB CD-ROM

° 2nd boot device: USB floppy

° 3rd boot device: USB SuperDisk

° 4th boot device: Notebook hard drive

° 5th boot device: USB hard disk

° 6th boot device: Network controller

Device configurations °

Swap the functions of the fn key and left ctrl key.

Enable/disable USB legacy support. When enabled, USB
legacy support allows the following:

° Use of a USB keyboard in Computer Setup even
when a your operating system is not running.

o Startup from bootable USB devices, including a hard
drive, diskette drive, or optical drive connected by a
USB port to the computer.

Enable/disable BIOS DMA data transfers.

Enable/disable fan always on while connected to an AC
outlet.

Enable/disable data execution prevention.
Enable/disable LAN power saving mode.
Enable/disable SATA Native Mode.
Enable/disable Dual Core CPU.

Enable/disable HDD translation mode.
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Select

To do this

Built-in device options

Enable/disable embedded WLAN Device Radio.
Enable/disable embedded Bluetooth Device Radio.
Enable/disable Network Interface Controller (NIC)
Enable/disable LAN/WLAN Switching.
Enable/disable Wake on LAN.

Enable/disable the integrated camera (webcam)

Port options

Enable/disable USB port.

Computer Setup menus
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6 Specifications

Device specifications

Metric u.s.
Dimensions
Depth 16.67 cm 6.56 in
Width 26.17 cm 10.30in
Height 2.52 cm 0.99in
Weight
10.1-in. LCD, equipped with a 3-cell battery, hard drive, 1-GB  1.11 kg 2.451b
memory, WLAN module, and 2 wireless antennas
10.1-in. LCD, equipped with a 3-cell battery,solid-state drive, 1.09 kg 2.401b
1-GB memory, WLAN module, and 2 wireless antennas
Input power
Operating voltage 19Vdec@1.58 A-30W
Operating current 1.58 A
Temperature
Operating 5°C to 35°C 41°F to 95°F
Nonoperating -20°C to 65°C -4°F to 149°F
Relative humidity (noncondensing)
Operating 10% to 90%
Nonoperating 0% to 95%
Maximum altitude (unpressurized)
Operating -15m to 3,048 m -50 ft to 10,000 ft
Nonoperating -15mto 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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10.1-inch, AntiGlare display specifications

Metric u.s.
Dimensions
Height 23.45cm 9.23in
Width 14.30 cm 5.62in
Diagonal 25.55cm 10.05in
Number of colors 262,144
Contrast ratio 400:1 (typical)
Brightness 200 nits (typical)
Pixel resolution
Pitch 0.2175 x 0.2175 mm
Format 1024 x 576
Configuration RGB vertical stripe
Backlight Edge lit
Character display 80 x 25
Total power consumption 3.2W
Viewing angle +/-45° horizontal, +15/-35° vertical (typical)
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Hard drive specifications

Dimensions

Height 9.5 mm
Width 70 mm
Weight 1019
Interface type PATA
Transfer rate 100 MB/sec
Security ATA security

Seek times (typical read, including setting)

Single track 3ms
Average 13 ms
Maximum 24 ms
Logical blocks 117,210,240
Disc rotational speed 4200 rpm

Operating temperature

* 1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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System DMA specifications

Hardware DMA

System function

DMAO Not applicable
DMA1 Not applicable
DMA2 Not applicable
DMA3 Not applicable
DMA4

Direct memory access controller
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System interrupt specifications

Hardware IRQ

System function

IRQO System timer
IRQ1 Standard 101-/102-key or Microsoft® Natural PS/2 Keyboard
IRQ8 System CMOS/real-time clock
IRQQ * Microsoft ACPI-compliant system
IRQ12 Synaptics PS/2 TouchPad
IRQ13 Numeric data processor
IRQ14 Primary IDE channel
IRQ15 Intel® 82801G (ICH7 Family) SMBus Controller—27DA
IRQ16 Broadcom 802.11b/g WLAN no. 2
Intel 82801G (ICH7 Family) PCI Express Root Port—27D0
Intel 82801G (ICH7 Family) USB Universal Host Controller—27CB
Microsoft UAA Bus Driver for High Definition Audio
Mobile Intel 945 Express Chipset Family
IRQ17 Intel 82801G (ICH7 Family) PCI Express Root Port—27D2
IRQ18 Intel 82801G (ICH7 Family) USB Universal Host Controller—27CA
IRQ19 Intel 82801G (ICH7 Family) USB Universal Host Controller—27C9
IRQ23 Intel 82801G (ICH7 Family) USB Universal Host Controller—27C8

Intel 82801G (ICH7 Family) USB2 Enhanced Host Controller—27CC

* Default configuration
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System I/O address specifications

1/0 address (hex)

System function (shipping configuration)

000 - O0F DMA controller

000 - CF7 PCI bus

010 - O1F Motherboard resources

020 - 021 Programmable interrupt controller

022 - O3F Motherboard resources

040 - 043 System timer

044 - O5F Motherboard resources

060 - 060 Standard 101-/102-key or Microsoft® Natural PS/2 Keyboard
061 - 061 System speaker

062 - 062 Microsoft ACPI-Compliant Embedded Controller
063- 063 Motherboard resources

064 - 064 Standard 101-/102-key or Microsoft Natural PS/2 Keyboard
065 - 065 Motherboard resources

066 - 066 Microsoft ACPI-Compliant Embedded Controller
067 - 06F Motherboard resources

070 - 071 System CMOS/real-time clock

072 - 07F Motherboard resources

080 - 080 Motherboard resources

081 - 083 DMA controller

084 - 086 Motherboard resources

087 - 087 DMA controller

088 - 088 Motherboard resources

089 - 08B DMA controller

08C - 08E Motherboard resources

08F - 08F DMA controller

090 - 09F Motherboard resources

0AO - 0A1 Programmable interrupt controller

0A2 - OBF Motherboard resources

0CO - ODF DMA controller

OEO - OEF Motherboard resources

OFO0 - OFF Numeric data processor

1F0 - 1F7 Primary IDE channel

274 - 277 ISAPNP Read Data Port

System /O address specifications
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1/0 address (hex)

System function (shipping configuration)

279 -279 ISAPNP Read Data Port

3B0 - 3BB Mobile Intel® 945 Express Chipset Family

3CO0 - 3DF Mobile Intel 945 Express Chipset Family

3F6 - 3F6 Primary IDE channel

400 - 41F Intel 82801G (ICH7 Family) SMBus Controller—27DA

480 - 4BF Motherboard resources

4D0 - 4D1 Motherboard resources

500 - 501 Motherboard resources

800 - 87F Motherboard resources

A79 - A79 ISAPNP Read Data Port

0D0O0 - FFFF PCl bus

D480 - D49F Intel 82801G (ICH7 Family) USB Universal Host Controller—27C8
D800 - D81F Intel 82801G (ICH7 Family) USB Universal Host Controller—27CA
D880 - D89F Intel 82801G (ICH7 Family) USB Universal Host Controller—27C9
DCO00 - DC1F Intel 82801G (ICH7 Family) USB Universal Host Controller—27C8
DC80 - DC87 Mobile Intel 945 Express Chipset Family

E000 - EFFF Intel 82801G (ICH7 Family) PCI Express Root Port—27D2

FFAO - FFAF Intel 82801G (ICH7 Family) Ultra ATA Storage Controllers—27DF
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System memory map specifications

Memory address

System function

00000000 - 0009FFFF

System board

000A0000 - 000BFFFF

Mobile Intel® 945 Express Chipset Family

000A0000 - 000BFFFF

PCI bus

000C0000 - 000CFFFF

System board

000D0000 - 000DFFFF

PCI bus

000E0000 - 0O00FFFFF

System board

00100000 - 3F7FFFFF

System board

3F800000 - DFFFFFFF

PCI bus

D0000000 - DFFFFFFF

Mobile Intel 945 Express Chipset Family

E0000000 - E3FFFFFF

Motherboard resources

E4000000 - FED8FFFF

PCl bus

FE880000 - FES8FFFFF

Mobile Intel 945 Express Chipset Family

FE937C00 - FE937FFF

Intel 82801G (ICH7 Family) USB2 Enhanced Host Controller—27CC

FE938000 - FE93BFFF

Microsoft® UAA Bus Driver for High Definition Audio

FE940000 - FE9Q7FFFF

Mobile Intel 945 Express Chipset Family

FE980000 - FEOFFFFF

Mobile Intel 945 Express Chipset Family

FEAO0000 - FEAFFFFF

Intel 82801G (ICH7 Family) PCI Express Root Port—27D0

FEAFCO000 - FEAFFFFF

Broadcom 802.11b/g WLAN

FEBO00OO - FEBFFFFF

Intel 82801G (ICH7 Family) PCI Express Root Port—27D2

FECO00000 - FECOOFFF

Motherboard resources

FED13000 - FED19FFF

System board

FED1CO000 - FED1FFFF

Motherboard resources

FED20000 - FED3FFFF

Motherboard resources

FED40000 - FED8FFFF

Motherboard resources

FED90000 - FFFFFFFF

System board

FEE00000 - FEEOOFFF

Motherboard resources

System memory map specifications
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7 Screw listing

This section provides specification and reference information for the screws and screw locks used in
the device. All screws listed in this section are available in the Screw Kit, spare part number 578362-001.

Phillips PM2.0%2.0 screw

=® b

mm Lol

Color Quantity Length Thread Head diameter
Silver 1 2.0 mm 2.0 mm 1.0 mm
Black 1 2.0 mm 2.0 mm 1.0 mm

Where used: One screw that secures the top cover to the base enclosure
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Where used: One screw that secures the top cover to the base enclosure.

Phillips PM2.0%2.0 screw 81



Phillips PM2.0%2.0 broadhead screw

1),

mm ool

Color Quantity Length Thread Head diameter

Black 3 2.0 mm 2.0 mm 1.0 mm

Where used: 3 screws that secure the power button board to the base enclosure
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Phillips PM2.0%3.0 screw

=® [o

mm Lot

Color Quantity Length Thread Head diameter
Silver 3 3.0 mm 2.0 mm 4.0 mm
Black 19 3.0 mm 2.0 mm 4.0 mm

Where used: 2 screws that secure the hard drive to the system board
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Where used: 4 screws that secure the hard drive bracket to the hard drive

T
I
I
I
I
I

_—————
_—————y

——— —— —

Where used: 4 screws that secure the top cover to the base enclosure

Where used: 2 screws that secure the speaker assembly to the top cover
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Where used: 2 screws that secure the fan and heat sink assembly to the system board

Where used: One screw that secures the system board to the base enclosure

Phillips PM2.0x3.0 screw 85



Phillips PM2.0x4.0 screw

® I

mm Lotohotndonl

Color Quantity Length Thread Head diameter

Silver 4 4.0 mm 2.0 mm 4.0 mm

Where used: 2 screws that secure the WWAN module to the system board
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Phillips PM2.0%6.0 screw

“@® fm

mm ool

Color Quantity Length Thread Head diameter

Silver 4 6.0 mm 2.0 mm 4.5 mm

Where used: 4 screws that secure the top cover to the base enclosure
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Phillips PM2.0x7.0 screw

" @ [

mm ool

Color Quantity Length Thread Head diameter

Silver 1 7.0 mm 2.0 mm 4.5 mm

Where used: One screw that secures the top cover to the base enclosure
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Phillips PM2.0x7.0 captive screw

“@® fm

mm Lttt

Color Quantity Length Thread Head diameter

Black 4 7.0 mm 2.0 mm 4.0 mm

Where used: 4 captive screws, with C-clips, that secure the fan and heat sink assembly to the system
board
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Phillips PM2.5%5.0 screw

=@ [m

mm Lottt

Color Quantity Length Thread Head diameter

Silver 6 5.0 mm 2.5 mm 4.5 mm

Where used: 6 screws that secure the display panel to the display enclosure
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Torx T8M2.5%5.0 screw

=@® [m

unmnmm

Color Quantity Length Thread Head diameter

Black 4 5.0 mm 2.5 mm 4.5 mm

1
I
I
I
I

Where used: 4 screws that secure the top cover to the base enclosure
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Phillips PM2.5%6.0 screw

=® [

mm Loohotndoonl

Color Quantity Length Thread Head diameter

Black 2 6.0 mm 2.5 mm 4.0 mm

Where used: 2 screws that secure the display assembly and top cover to the device
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Phillips PM2.5%11.0 captive screw

SOM

mm Lot

Color Quantity Length Thread Head diameter

Black 1 11.0 mm 2.5 mm 4.0 mm

Where used: One captive screw, with a C-clip, that secures the hard drive bracket to the base enclosure

Phillips PM2.5%x11.0 captive screw 93



8 Backup and recovery

Select the section in this chapter that applies to the operating system installed on your computer.
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SUSE Linux Recovery
Use the instructions in this section if SUSE Linux SLED 11 is installed on your computer.

To protect your information, back up your files and folders. Then if the system fails, you can restore your
important files from copies. You can also use the options listed in this section to restore the operating
system and programs that were installed at the factory.

/A CAUTION: Usingf11 completely erases hard drive contents and reformats the hard drive. All files you
have created and any software installed on the computer are permanently removed. The 11 recovery
tool reinstalls the original operating system and HP programs and drivers that were installed at the
factory. Software, drivers, and updates not installed by HP must be manually reinstalled. Personal files
must be restored from a backup.

To recover the original hard drive image using 11, follow these steps:
1. If possible, back up all personal files.

2. Restart the computer, and then press f11 while the “Press <F11> for recovery” message is
displayed on the screen.

3. Follow the on-screen instructions.
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Windows Vista backup and recovery

Use the instructions in this section if Windows Vista is installed on your computer.

To protect your information, use the Backup and Restore Center to back up individual files and folders,
back up your entire hard drive (select models only), or create system restore points. In case of system
failure, you can use the backup files to restore the contents of your computer.

Windows Vista® provides the following advanced backup and recovery options:
e  Backing up individual files and folders

e  Backing up the entire hard drive (select models only)

e  Scheduling automatic backups (select models only)

e  Creating system restore points

e Recovering individual files

e Restoring the computer to a previous state

e Recovering information using recovery tools

Bf NOTE: For instructions on these procedures, go to Help and Support.

Backing up

Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

Note the following when backing up:
e  Store personal files in the Documents folder, and back it up regularly.
e Back up templates that are stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3.  Open a word-processing document, and then select Edit > Paste.
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The screen image is added to the document.
4. Save the document.

e  When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend on
the type of optional external optical drive you use.

Bf NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

e  When backing up to discs, number each disc before inserting it into the optional external optical
drive.

To create a backup using Backup and Restore Center, follow these steps:

Bf NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Click Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your files.

Bf NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

Recovering

In case of system failure, use the f11 recovery tool to recover your original hard drive image.

Bf NOTE: The image includes the Windows® operating system and software programs installed at the
factory.

/A CAUTION: Usingf11 completely erases hard drive contents and reformats the hard drive. All files you
have created and any software installed on the computer are permanently removed. The 11 recovery
tool reinstalls the operating system and HP programs and drivers that were installed at the factory.
Software not installed at the factory must be reinstalled. Personal files must be restored from a backup.

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, click Start
> Computer.

B NOTE: If the HP Recovery partition has been deleted, you will need to recover your operating
system and programs using the Windows Vista Operating System and the Driver Recovery discs
(purchased separately). For additional information, contact technical support by selecting Start >
Help and Support > Contact support.

3. Turnon orrestart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

4. Press f11 while the “Press 11 for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Windows Vista backup and recovery 97



B NOTE: Windows Vista provides additional recovery tools through the operating system. For additional
information, go to Help and Support.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista
Operating System DVD to reboot the computer and repair the operating system. For additional
information, contact technical support by selecting Start > Help and Support > Contact support.
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Windows XP backup and recovery

Use the instructions in this section if Windows XP is installed on your computer.

To protect your information, use the Windows® Backup utility to back up files and folders or create
recovery points. In case of system failure, you can use the backup files to restore your computer.

Bf NOTE: Windows Backup utility is available only on the notebooks with the Windows XP Professional
operating system. If your notebook has Windows XP Home, you can back up your personal files to a
USB external hard drive (purchased separately).

Windows XP Professional provides the following advanced backup and recovery options:
e Backing up individual files and folders

e Backing up all files and folders

e  Scheduling automatic backups (select models only)

e  Scheduling automatic backups

e Creating recovery points

e Recovering information

Bf NOTE: For instructions on these procedures, go to Help and Support.

Backing up

Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

In Windows XP Professional, use the Windows Backup utility to create a backup. Click Start > All
Programs > Accessories > System Tools > Backup. Follow the on-screen instructions to back up
your files.

In Windows XP Home, copy data files to a USB external hard drive (purchased separately).

Recovering

In case of system failure or instability, use the Operating System disc and the Driver Recovery discs
that are included with the computer to recover your operating system and programs.

/A CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system as well as software and drivers. Software, drivers, and updates
not installed by HP must be manually reinstalled. Personal files must be restored from a backup.

1.  If possible, back up all personal files.

2.  Shut down the computer.

3. Insert the Operating System disc into an optional external optical drive.
4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.
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6. After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.

B NOTE: For additional information, go to Help and Support.
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9 Connector pin assignments

Audio-in (microphone)

Pin Signal
1 Audio signal in
2 Audio signal in
3 Ground

Audio-in (microphone) 101



Audio-out (headphone)

Pin Signal

1 Audio out, left channel
2 Audio out, right channel
3 Ground
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External monitor

®OO00®
®000 W
©000G

Pin Signal

1 Red analog

2 Green analog
3 Blue analog

4 Not connected
5 Ground

6 Ground analog
7 Ground analog
8 Ground analog
9 +5VDC

10 Ground

11 Monitor detect
12 DDC 2B data
13 Horizontal sync
14 Vertical sync
15 DDC 2B clock

External monitor 103



RJ-45 (network)

Pin Signal

1 Transmit +
2 Transmit -
3 Receive +
4 Unused

5 Unused

6 Receive -
7 Unused

8 Unused
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Universal Serial Bus

1 2 3 4
I--_-_-.I

Pin Signal
1 +5VDC
2 Data -
3 Data +
4 Ground

Universal Serial Bus 105



10 Power cord set requirements

The wide range input feature of the device permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the device meets the requirements for use in the country
or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the device is used.

Requirements for all countries and regions

The requirements listed below are applicable to all countries and regions:
e The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

e All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

e  The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

e The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the device.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
Italy IMQ 1
Japan METI 3
The Netherlands KEMA 1
Norway NEMKO 1
The People's Republic of China CCC 5
South Korea EK 4
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States uL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. Theflexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm? conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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11 Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display

/A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

/A CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
When you remove these components, handle them carefully.

EE)

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or
see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

9 —-

Bf NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3.  Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

!
i-

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

o

u
o\

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

/A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18.

19.
20.
21.
22,

Remove the backlight from the backlight frame.

Disconnect the display panel cable (1) from the LCD panel.

Remove the screws (2) that secure the LCD panel to the display rear panel.

Release the LCD panel (3) from the display rear panel.

Release the tape (4) that secures the LCD panel to the display rear panel.

24. Recycle the LCD panel and backlight.
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Index

A

AC adapter, spare part
number 20

antenna

removal 58
spare part number 19, 22,
52

antennas 13
applications key, Windows 7
audio, product description 2
audio-in (microphone) jack 9
audio-out (headphone) jack 9
audio-in jack

pin assignments 101
audio-out jack

pin assignments 102

B
backingup 96, 99
base enclosure, spare part
number 18
battery
removal 32
spare part number 18, 32
battery bay 12
battery release latches,
identifying 12
Bluetooth module
removal 50
spare part number 18, 50
boot options 70
boot order 70
buttons
power 6
Quick Launch Mail 6
Quick Launch Web 6
TouchPad 4

Cc

cables, service considerations 25

114 Index

caps lock light, identifying 5
chipset, product description 1

components
bottom 12
display 11
front 8
left-side 10
right-side 9
top 4

Computer Setup

Diagnostic menu 69

File menu 68

navigating and selecting 67

restoring factory settings 67

Security menu 69

System Configuration

menu 70

connector, power 10
connectors

service considerations 25

D
device feet

locations 31

spare part number 31
device specifications 72
Diagnostic menu 69
diskette drive

precautions 26

product description 1
display assembly

removal 52

spare part number 16, 52
display bezel

illustrated 19, 52

removal 53

spare part number 19, 52
Display Cable Kit, spare part

number 19, 22, 52

display component recycling 108

display components 11
display enclosure

illustrated 19, 52

spare part number 19, 52
Display Hinge Kit, spare part

number 19, 52

display hinge, removal 56
display panel

illustrated 52

spare part number 52
display panel/webcam cable

illustrated 19

spare part number 19
display specifications 73
drive light 8
drives

preventing damage 26
drives, boot order 70

E
electrostatic discharge 27
embedded numeric keypad keys,
identifying 7
esc key, identifying 7
Ethernet, product description 2
external media cards, product
description 2
external monitor port
pin assignments 103
external monitor port,
identifying 10

F
fan

removal 63

spare part number 63
feet

locations 31

spare part number 31
File menu 68



fn key, identifying 7
function keys, identifying 7

G

graphics, product description

grounding equipment and
methods 29

H

hard drive
precautions 26
product description 1
specifications 74

headphone jack

pin assignments 102

|

I/0O address specifications 77

internal microphones,
identifying 11

interrupt specifications 76

J

jacks
audio-in (microphone) 9
audio-out (headphone) 9
RJ-45 (network) 9

K
keyboard
product description 2
removal 36
spare part number
keys
esc 7
fn 7
function 7
keypad 7
Windows applications 7
Windows logo 7

16, 36

L
labels

service tag 12
latches, battery release 12
legacy support, USB 66, 70
lights

caps lock 5

drive 8

power 5, 10

Quick Launch Mail 5

1

Quick Launch Web 5
webcam 11
wireless 8

M
mass storage device
product description 1
spare part number 17
memory map specifications 79
memory module
product description 1
removal 34
spare part number 18, 34
memory module compartment
cover
removal 34
memory module compartment,
identifying 12
microphone assembly, spare part
number 19, 22, 52
microphone jack
pin assignments 101
microphones, internal 11
model name 1
modem, product description 2
monitor port
pin assignments 103
monitor port, external 10

N
network jack

pin assignments 104

o

operating system, product
description 2

optical drive, product
description 1

P

packing guidelines 28

panels, product description 1

passwords 69

pin assignments
audio-in jack 101
audio-out jack 102
external monitor port
headphone jack 102
microphone jack 101
monitor port 103
network jack 104

103

RJ-45 jack 104
Universal Serial Bus (USB)
port 105
plastic parts 25
pointing device
product description 2
ports
external monitor 10
product description 2
USB 9, 10
power button, identifying 6
power connector, identifying
power cord
set requirements 106
spare part number 20
power light 10
power light, identifying 5
power requirements, product
description 2
processor, product description
product description
audio 2
chipset 1
diskette drive 1
Ethernet 2
external media cards 2
graphics 1
hard drive 1
keyboard 2
mass storage device 1
memory module 1
modem 2
operating system 2
optical drive 1
panels 1
pointing device 2
ports 2
power requirements 2
processors 1
product name 1
security 2
serviceability 2
wireless 2
product name 1
product name and number,
computer 12

Q
Quick Launch Mail light,
identifying 5
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Quick Launch Mail, identifying 6

Quick Launch Web button,
identifying 6

Quick Launch Web light,
identifying 5

R
recovering 97, 99
release latches, battery 12
removal/replacement
preliminaries 25
procedures 30
RJ-45 (network) jack,
identifying 9
RJ-45 jack
pin assignments 104
RTC battery
removal 61
spare part number 18, 61

Rubber Kit, spare part number 20

S
Screw Kit

contents 80

spare part number 20
screw listing 80
scrolling regions, TouchPad 4
SD Card Reader 9
security cable slot, identifying 9
Security menu 69
security, product description 2
serial number 14, 30
serial number, computer 12
service considerations 25
servicetag 12, 14, 30
serviceability, product

description 2

setup utility

Diagnostic menu 69

File menu 68

restoring factory settings 67

Security menu 69

System Configuration

menu 70
SIM
removal 33
slots

security cable 9
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speaker assembly

illustrated 17

spare part number 17
speakers, identifying 8, 11
specifications

device 72

display 73

hard drive 74

I/O addresses 77

interrupts 76

memory map 79

system DMA 75
static-shielding materials 29
stringent security 69
switches

wireless 8
system board
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